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Course Goals

ÅBecome comfortable with the LabVIEW environment 

and data flow execution

ÅAbility to use LabVIEW to solve problems

ÅLabVIEW Concepts

ïAcquiring, saving and loading data

ïFind and use math and complex analysis functions

ïWork with data types, such as arrays and clusters

ïDisplaying and printing results
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The Virtual Instrumentation Approach
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LabVIEW Graphical Development System

ÅGraphical Programming Environment

ÅCompile code for multiple OS and devices

ÅUseful in a broad range of applications
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Virtual Instrumentation Applications
ÅDesign

ïSignal and Image Processing

ïEmbedded System Programming

Å(PC, DSP, FPGA, Microcontroller)

ïSimulation and Prototyping

ïAnd moreé

ÅControl

ïAutomatic Controls and Dynamic Systems

ïMechatronics and Robotics

ïAnd moreé

ÅMeasurements

ïCircuits and Electronics

ïMeasurements and Instrumentation

ïAnd moreé

Design Prototype Deploy

A single graphical development platform
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The NI Approach ðIntegrated Hardware Platforms

High-Speed
Digitizers

High-Resolution
Digitizers and DMMs

Multifunction 
Data Acquisition

Dynamic
Signal Acquisition

Digital I/OInstrument
Control

Counter/
Timers

Machine
Vision

Motion 
Control

Distributed I/O and
Embedded Control

Laptop PC PDADesktop PCPXI Modular Instrumentation

Signal Conditioning
and Switching

Unit Under Test
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Section I ðLabVIEW Environment
A. Getting Data into your Computer
ÅData Acquisition Devices

ïNI-DAQ

ïSimulated Data Acquisition

ïSound Card

B. LabVIEW Environment
ÅFront Panel / Block Diagram

ÅToolbar /Tools Palette

C. Components of a LabVIEW Application
ÅCreating a VI

ÅData Flow Execution

D. Additional Help
ÅFinding Functions

ÅTips for Working in LabVIEW
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A. Setting Up Your Hardware

ÅData Acquisition Device (DAQ)
ïActual USB, PCI, or PXI Device

ïConfigured in MAX

ÅSimulated Data Acquisition Device (DAQ)
ïSoftware simulated at the driver level

ïConfigured in MAX

ÅSound Card
ïBuilt into most computers

Track A

Track B

Track C
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What type of device should I use? 

Sound Card* NI USB DAQ NI PCI DAQ Instruments*

AI Bandwidth 8ð44 KS/s 10ð200 KS/s 250 Kð1.2 Ms/s 20kS/sð2 GS/s

Accuracy 12ð16 bit 12ð16 bit 14ð18 bit 12ð24 bit

Portable x x ñ some

AI Channels 2 8ð16 16ð80 2

AO Channels 2 1ð2 2ð4 0

AC or DC AC AC/DC AC/DC AC/DC

Triggering ñ x x x

Calibrated ñ x x x

* The above table may not be representative of all device variations that exist in each category
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What is MAX?
ÅMAX stands for Measurement & Automation Explorer.

ÅMAX configures and organizes all your National Instruments DAQ, 
PCI/PXI instruments, GPIB, IMAQ, IVI, Motion, VISA, and VXI devices.

ÅUsed for configuring and testing devices.

Icon Found on

Windows Desktop
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Exercise 1 ðSetting Up Your Device

ÅUse Measurement and Automation Explorer (MAX) to:

ïConfigure and test your Data Acquisition (DAQ) device

Track A
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Exercise 1 ðSetting Up Your Device

ÅUse Measurement and Automation Explorer (MAX) to:
ïConfigure and test your Simulated Data Acquisition (DAQ) device

Track B
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Exercise 1 ðSetting Up Your Device

ÅUse Windows to:

ïVerify your Sound Card

Track C

Un-Mute Microphone
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Start»All Programs»National Instruments LabVIEW 8.6

Startup Screen:

Start from a Blank VI:

New»Blank VI

Start from an Example:

Examples»Find 

Examplesé

»

or

Open and Run LabVIEW
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Each VI has2 Windows

Front Panel

ÅUser Interface (UI)
ïControls = Inputs

ïIndicators = Outputs

Block Diagram

ÅGraphical Code
ïData travels on wires from 

controls through functions to 

indicators

ïBlocks execute by Dataflow

LabVIEW Programs Are Called Virtual Instruments (VIs)
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Controls Palette

(Controls & Indicators)
(Place items on the Front Panel Window)

Indicator:
Numeric Slide

Control:
Numeric

Customize 

Palette 

View

../../eluther/ni.com/
../../eluther/www.ni.com/
http://www.ni.com/


Functions (and Structures) Palette

(Place items on the
Block Diagram Window)

Structure:
While Loop
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Run Button 

Continuous Run Button

Abort Execution

Execution Highlighting Button

Additional Buttons on 
the Diagram Toolbar

Status Toolbar

Retain Wire Values Button

Step Function Buttons
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Block Diagram Window

Front Panel Window

Demonstration 1: Creating a VI

Input
Terminals

Output
Terminal

Boolean
Control

Graph
Indicator
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ÅBlock diagram execution

ïDependent on the flow of data

ïBlock diagram does NOT execute 

left to right

ÅNode executes when data is 

available to ALL input terminals

ÅNodes supply data to all output 

terminals when done

Dataflow Programming
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Debugging Techniques

ÅFinding Errors

ÅExecution Highlighting

ÅProbes

Click on broken Run button.

Window showing error appears.

Click on Execution Highlighting button; data 
flow is animated using bubbles. Values are 
displayed on wires.

Right-click on wire to display probe and it shows 
data as it flows through wire segment. 

You can also select Probe tool from Tools palette 
and click on wire.
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Exercise 2 ðAcquiring a Signal with DAQ
Track A&B

This exercise should take 15 minutes.

ÅUse a LabVIEW template to:

ïAcquire a signal from your DAQ 

device
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Exercise 2 ðAcquiring a Signal with the Sound Card

Track C

ÅUse LabVIEW to:

ïAcquire a signal from your sound card

This exercise should take 15 minutes.
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Context Help Window

ÅHelp»Show Context Help, press the <Ctrl+H> keys

ÅHover cursor over object to update window

Additional Help

ïRight-Click on the VI icon and 

choose Help, or

ïChoose ñDetailed Help.ò on 

the context help window
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Tips for Working in LabVIEW

ÅKeystroke Shortcuts

ï<Ctrl+H> ïActivate/Deactivate Context Help Window

ï<Ctrl+B> ïRemove Broken Wires From Block Diagram

ï<Ctrl+E> ïToggle Between Front Panel and Block 

Diagram

ï<Ctrl+Z> ïUndo (Also in Edit Menu)

ÅToolsèOptionséïSet Preferences in LabVIEW

ÅVI PropertiesïConfigure VI Appearance, 

Documentation, etc.
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Section II ðElements of Typical Programs

A. Loops
ÅWhile Loop

ÅFor Loop

B. Functions and SubVIs
ÅTypes of Functions

ÅCreating Custom Functions (SubVI)

ÅFunctions Palette & Searching

C. Decision Making and File IO
ÅCase Structure

ÅSelect (simple If statement)

ÅFile I/O
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Loops

ÅWhile Loops
ïi terminal counts iteration

ïAlways runs at least once

ïRuns until stop condition is 

met

ÅFor Loops
ïi terminal counts iterations

ïRun according to input N of 

count terminal

While Loop

For Loop
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Drawing a Loop

1. Select the structure

2. Enclose code to be repeated

3. Drop or drag additional nodes and then wire
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3 Types of Functions (from the Functions Palette)

Express VIs: interactive VIs with configurable dialog page (blue border)

Standard VIs: modularized VIs customized by wiring(customizable)

Functions:fundamental operating elements of LabVIEW; no front panel or 
block diagram (yellow)
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What Types of Functions are Available?
ÅInput and Output

ïSignal and Data Simulation

ïAcquire and Generate Real Signals with DAQ

ïInstrument I/O Assistant (Serial & GPIB)

ïActiveX for communication with other programs

ÅAnalysis 

ïSignal Processing

ïStatistics

ïAdvanced Math and Formulas

ïContinuous Time Solver

ÅStorage

ïFile I/O

Express Functions Palette

../../eluther/ni.com/
../../eluther/www.ni.com/
http://www.ni.com/


Searching for Controls, VIs, and Functions

ÅPalettes are filled with hundreds 

of VIs

ÅPress the search button to index the 

all VIs for text searching

ÅClick and drag an item from the 

search window to the block diagram 

ÅDouble-click an item to open the 

owning palette
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Create SubVI

ÅEnclose area to be converted into a subVI.

ÅSelect Edit»Create SubVIfrom the Edit Menu.
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LabVIEW Functions and SubVIs operate like Functions 
in other languages

Function Pseudo Code
function average (in1, in2, out)

{

out = (in1 + in2)/2.0;

}

SubVI Block Diagram

Calling Program Pseudo Code
main

{

average (in1, in2, pointavg)

}

Calling VI Block Diagram
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Exercise 3.1 ðAnalysis 
Track A,B,&C

ÅUse LabVIEW Express VIs to:

ïSimulate a signal and display its amplitude and frequency

This exercise should take 

15 minutes.
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Exercise 3.2 ðAnalysis 
Track A&B

ÅUse LabVIEW Express VIs to:

ïAcquire a signal and display its amplitude and frequency

This exercise should take 15 minutes.
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Exercise 3.2 ðAnalysis 
Track C

ÅUse LabVIEW Express VIs to:

ïAcquire a signal and display its amplitude and frequency

This exercise should take 15 minutes.
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How Do I Make Decisions in LabVIEW?

1. Case Structures

2. Select
(a) (b)

(c)
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File I/O

File I/Oïpassing data to and from files

ÅFiles can be binary, text, or spreadsheet

ÅWrite/Read LabVIEW Measurements file (*.lvm)

Writing to LVM file Reading from LVM file
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Exercise 3.3 ðDecision Making and Saving Data

ÅUse a case structure to:

ïMake a VI that saves data when a condition is met

This exercise should take 15 

minutes.

Track A,B,C

../../eluther/ni.com/
../../eluther/www.ni.com/
http://www.ni.com/


File I/O Programming Model ðUnder the hood

Open/

Create/

Replace File

Read 

and/or

Write to File

Close 

File

Check for

Errors
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Section III ðPresenting your Results

A. Displaying Data on the Front Panel

ÅControls and Indicators

ÅGraphs and Charts

ÅLoop Timing

B. Signal Processing

ÅMathScript

ÅArrays

ÅClusters

ÅWaveforms
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What Types of Controls and Indicators are Available?
ÅNumeric Data
ïNumber input and display

ïAnalog Sliders, Dials, and Gauges

ÅBoolean Data
ïButtons and LEDs

ÅArray & Matrix Data
ïNumeric Display

ïChart

ïGraph

ïXY Graph

ïIntensity Graph

ï3D graph: point, surface, and model

ÅDecorations
ïTab Control

ïArrows

ÅOther
ïStrings and text boxes

ïPicture/Image Display

ïActiveX Controls

Express Controls Palette
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Charts ðAdd 1 data point at a time with history
Waveform chartïspecial numeric indicator that can 
display a history of values

ÅChart updates with each individual point it receives

Functions»Express»Graph Indicators»Chart
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Graphs ðDisplay many data points at once
Waveform graphïspecial numeric indicator that 
displays an array of data

ÅGraph updates after all points have been collected

ÅMay be used in a loop if VI collects buffers of data

Functions»Express»Graph Indicators»Graph
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ÅLoops can accumulate 

arrays at their boundaries 

with auto-indexing

ÅFor Loops auto-index by 

default

ÅWhile Loops output only 

the final value by default

ÅRight-click tunnel and 

enable/disable auto-

indexing

Building Arrays with Loops (Auto-Indexing)

Wire becomes thicker

Wire remains the same size

Auto-Indexing Disabled

Auto-Indexing Enabled

Only one value (last iteration) 

is passed out of the loop

1D Array

0 1 2 3 4 5

5
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Creating an Array (Step 1 of 2)

From the Controls»Modern»Array, Matrix, and 

Cluster subpalette, select the Array icon.

Drop it on the Front Panel.
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Create an Array (Step 2 of 2)

1. Place an Array Shell.

2. Insert datatype into the shell (i.e. Numeric Control).
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How Do I Time a Loop?
1. Loop Time Delay
ÅConfigure the Time Delay Express VI for seconds to wait 

each iteration of the loop (works on For and While loops).

2. Timed Loops
ÅConfigure special timed While loop for desired dt.

Timed LoopTime Delay
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Control & Indicator Properties

ÅProperties are characteristics or qualities about an object

ÅProperties can be found by right clicking on a Control or Indicator

ÅProperties Include:

ïSize

ïColor

ïPlot Style

ïPlot color

ÅFeatures include:

ïCursors

ïScaling
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Exercise 4.1 ðManual Analysis Track A,B,&C

ÅUse the cursor legend on a graph to:

ïVerify your frequency and amplitude measurements

This exercise should take 15 

minutes.

../../eluther/ni.com/
../../eluther/www.ni.com/
http://www.ni.com/


Textual Math in LabVIEW

ÅIntegrate existing scripts with LabVIEW for faster development

ÅInteractive, easy-to-use, hands-on learning environment

ÅDevelop algorithms, explore mathematical concepts, and 

analyze results using a single environment

ÅFreedom to choose the most effective syntax, whether 

graphical or textual within one VI

Supported Math Tools:

MathScript script node MathSoft software

Mathematica software MATLAB® software

Maplesoftware Xmathsoftware

MATLAB ® is a registered trademark of The MathWorks, Inc.
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Math with the MathScript Node
ÅImplement equations and algorithms textually

ÅInput and Output variables created at the border

ÅGenerally compatible with popular m-file script language

ÅTerminate statements with a semicolon to disable immediate 

output

Prototype your equations in the interactive MathScript Window.

(Functions»Programming»

Structures»MathScript)
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The Interactive MathScript Window

ÅRapidly develop and test algorithms 

(LabVIEW»Tools»MathScript Window)

Output

Window

Variable

Workspace

View/Modify

Variable Contents

User Commands

m-file Script

ÅShare Scripts and 

Variables with the Node

ÅView /Modify Variable 

content in 1D, 2D, and 3D
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Exercise 4.2 ðUsing MathScript
Use the MathScript Node and Interactive Window to process the 
acquired signal (logarithmic decay) in the MathScript and save 
the script.

Track A,B,&C

This exercise should take 25 

minutes.
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Review of Data Types Found in LabVIEW
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Exercise 5 ðApply What You Have Learned
Track A,B,&C

This exercise should take 20 minutes.
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Section IV ðAdvanced Data Flow Topics (optional)

A. Additional Data types
ÅCluster

B. Data Flow Constructs
ÅShift Register

ÅLocal Variables

C. Large Application Development
ÅNavigator Window

ÅLabVIEW Projects
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Introduction to Clusters

ÅData structure that groups data together

ÅData may be of different types

ÅAnalogous to struct in C

ÅElements must be either all controls or all indicators

ÅThought of as wires bundled into a cable

ÅOrder is important
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Creating a Cluster

1. Select a Clustershell.

Controls»Modern»Array, Matrix & Cluster

2. Place objects inside the shell.
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Cluster Functions
ÅIn the Cluster & Variant subpalette of the 

Programming palette

ÅCan also be accessed by right-clicking the cluster 
terminal

Bundle

(Terminal labels 
reflect data type)

Bundle By Name
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Using Arrays and Clusters with Graphs

The Waveform Datatype contains 3 pieces of data:

Åt0 = Start Time

Ådt = Time between Samples

ÅY = Array of Y magnitudes

Two ways to create a Waveform Cluster:

Build Waveform (absolute time) Cluster (relative time)
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Shift Register ðAccess Previous Loop Data

Å Available at left or right border of loop structures

Å Right-click the border and select Add Shift Register

Å Right terminal stores data on completion of iteration

Å Left terminal provides stored data at beginning of next iteration

Before 
Loop

Begins
First 

Iteration
Second
Iteration 

Last
Iteration 

Value 3
Initial
Value
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Local Variables
ÅLocal Variables allow data to be passed between parallel loops.

ÅA single control or indicator can be read or written to from more than one 

location in the program

ïLocal Variables break the dataflow paradigm and should be used sparingly
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ÅShows the current region of view 
compared to entire Front Panel or 
Block Diagram

ÅGreat for large programs

LabVIEW Navigation Window

* Organize and reduce program visual size with subVIs
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LabVIEW Project

ÅGroup and organize VIs

ÅHardware and I/O management

ÅManage VIs for multiple targets

ÅBuild libraries and executables

ÅManage large LabVIEW applications

ÅEnable version tracking and management

(LabVIEW»Project»New)
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Additional Resources
ÅNI Academic Web & Student Corner

ïhttp://www.ni.com/academic

ÅConnexions: Full LabVIEW Training Course

ïwww.cnx.rice.edu

ïOr search for ñLabVIEW basicsò

ÅLabVIEW Certification

ïLabVIEW Fundamentals Exam (free on www.ni.com/academic)

ïCertified LabVIEW Associate Developer Exam (industry recognized certification )

ÅGet your own copy of LabVIEW Student Edition

ïwww.ni.com/academic
By Robert H Bishop.

Published by Prentice Hall.
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The LabVIEW Certification Program

Certified LabVIEW 

Developer

Certified LabVIEW Associate 

Developer

Certified 

LabVIEW 

Architect

Architect
ÅMastery of LabVIEW 

ÅExpert in large application development

ÅSkilled in leading project teams

Developer
ÅAdvanced LabVIEW knowledge 

and application development 

experience

ÅProject management skills

Associate Developer
ÅProficiency in navigating

LabVIEW environment

ÅSome application 

development experience

Fundamentals Exam
ÅPre-Certification Skills Test Free On-Line Fundamentals Exam
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Electronics Workbench and Multisim

ÅWorldôs most popular software for 

learning electronics

Å180,000 industrial and academic users

ÅProducts include:

ïMultisim: Simulation and Capture

ïMulti-MCU: Microcontroller Simulation

ïMultiVHDL: VHDL Simulation

ïUltiboard: PCB Layout

ïElectronics CBT: Computer-based training

ÅLow cost student editions available

Åwww.electronicsworkbench.com
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Multisim Integrated with LabVIEW
1. Create Schematic 2. Virtual Breadboard 3. Simulate

4. PCB Layout 5. Test 6. Compare
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